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この資料の変更履歴は以下の通りです。  

版  発行日 変更内容 
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第 1.1 版 2020/11/17 システム要件追記、ダウンロードページ画面挿入、Hotfix1 案

内、HTTP 設定を更新、「KWA 日本語 OS 対応」追加 

第 1.2 版 2020/12/24 v9.7.1 用に更新 

第 1.3 版 2021/02/02 v9.7.2 インストール＆アップグレード(9.7.0/9.7.1→9.7.2)に更新 
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1 はじめに 

このドキュメントは、 

・Kiwi Syslog Server v9.7.2 を OS: Windows Server 2019 に初めてインストールする手順（2 章から） 

・9.7.0/9.7.1 から 9.7.2 へアップグレードする手順 （4 章から） 

を紹介します。 

Kiwi Web Access で利用のブラウザーは、Internet Explorer 11 を使用した例です。 

 

2 Kiwi Syslog Server 9.7システム要件 

Kiwi Syslog Server をインストールするコンピューターがハードウェアとソフトウェアの最小要件を満

たしているか等、必ずシステム要件を確認し、注意事項もご確認ください。 

注意： 前提モジュールである.NET Framework についてはオフライン環境の場合、事前にお客様

においてインストールしてください。  

 

3 Kiwi Syslog Server 9.7 インストール手順 

Kiwi Syslog Server 9.7 をインストール前は、「コントロールパネル＞プログラムと機能」での表示は

以下となっているマシンでの作業例です。 

 

 

3.1 前提モジュールのインストール 

3.1.1 .NET Framework 3.5をインストール 

1. サーバーマネージャーのメニューバー右上の「管理(M)」から「役割と機能の追加」を選択し

https://www.jtc-i.co.jp/product/kiwisyslogserver/kiwisyslogserver_system.html
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ます。 

2. 「役割と機能の追加ウィザード」が起動します。 

 

3. 「次へ」を 4 回押下し、「機能」の画面を表示します。 

 

 

4. NET Framework 3.5 Features 内の 

NET Framework 3.5(.NET 2.0 および 3.0 を含む)にチェックをいれ、「次へ」をクリックします。 
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5. 「インストール」をクリックします。 

 

 

 

注意：インターネットに接続できない環境で、NET Framework 3.5の機能を追加する場合は、Windows

のインストールメディアを「代替ソース パスの指定」で設定していただく必要があります。 
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<オフライン画面 例①> 

「代替ソース パスの指定」をクリックします。 

 

<オフライン画面 例②> 

インストールメディアをDドライブにセットした場合の例：D:\sources\sxs 

 

<オフライン画面 例③> 

「必要に応じて対象サーバーを自動的に再起動する」にチェックし、「はい」をクリック後、「インストール」

をクリックします。 
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インストールが始まります。 

 

 

6. インストールが終了したら、「閉じる」をクリックします。 
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3.1.2 .NET Framework 4.8 をインストール 

Web ブラウザーでシスログを閲覧できる Kiwi Web Access v1.6.2 をインストールする場合で、 

オフライン環境の場合、事前に.NET Framework 4.8 をインストールする必要があります。 

.NET Framework 4.8 インストーラーは Web ブラウザーの検索機能において「Windows 用の 

Microsoft .NET Framework 4.8 オフライン インストーラー」のキーワードで検索して入手しインスト

ールしてください。 

なお、オンライン環境の場合は、Kiwi Web Access インストーラーにより自動でダウンロードされて

インストールされますので事前インストールは不要です。 

 

3.2 インストールの準備 

□ 

 

リリースノートの確認 Kiwi Syslog Server バージョンヒストリーでリリース情報を確認します。 

□ 

 

システム要件を確認 インストールするコンピューターがハードウェアとソフトウェアの最小

要件を満たしているか等、システム要件を確認します。 

前提モジュールについてはインストールするプログラムや環境に応じ

た必要な対応をしてください。 

□ 

 

Windows Update Windows Update を最新の状態にしてください。Windows Update が実

行されると、システム再起動が必要となる場合があります。 

□ 

 

オープンポート インストールするコンピューターの Windows ファイアウォールが、Kiwi 

Syslog Server に必要なポートにおいてトラフィックの通過を許可して

https://www.jtc-i.co.jp/support/releasenote/releasenote_kiwisyslog.html
https://www.jtc-i.co.jp/product/kiwisyslogserver/kiwisyslogserver_system.html
https://www.jtc-i.co.jp/product/kiwisyslogserver/kiwisyslogserver_system.html
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いることを確認してください。 

利用ポートは、システム要件、または、Kiwi FAQ の Q5-6: Kiwi 

Syslog Server の実行で必要なポートは何ですか？を参照してください。 

□ ウイルス対策ソフトウ

ェア（アンチウイルス

ソフト）を確認 

Kiwi Syslog Server をインストールするコンピューターにアンチウイル

スソフトがインストールされてあれば、製品に関連するディレクトリを

除外します。 

例：Windows Server 2016 では、次のディレクトリを除外します。 

 C:\Program Files (x86)\Syslogd 

 C:\Program Files (x86)\UltiDev 

 C:\ProgramData\SolarWinds\ 

 C:\ProgramData\UltiDev 

関連情報が Kiwi FAQ Q4-5: アンチウイルスソフトのスキャン対象外

にする必要がありますか？にありますのでご参照ください。 

※Kiwi Syslog Server インストール前に除外設定が出来ない場合は

インストール後に設定を行ってください。 

 

3.3 Kiwi Syslog Server 9.7.x評価版インストーラーパッケージ(.zip)の入手 

Kiwi Syslog Server 9.7.x の評価版インストーラーパッケージ(.zip)を入手します。 

評価版をインストール後 14 日間はライセンス登録なしで、”Send SNMP Trap”アクションのなりす

まし転送を除く、全機能をご利用いただけます。 

ライセンスを登録すると正規版となります。 

 

1. 弊社のダウンロードサイトにアクセスし必要事項を入力すると以下の画面が表示されます。

「Kiwi 製品」をクリックします。 

 

https://www.jtc-i.co.jp/product/kiwisyslogserver/kiwisyslogserver_system.html
https://www.jtc-i.co.jp/faq/faq_kiwisyslog.html
https://www.jtc-i.co.jp/faq/faq_kiwisyslog.html
https://www.jtc-i.co.jp/support/download/
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2. 以下の画面が表示されますので、【単体】にある「Kiwi Syslog Server」をクリックします。 

下方の「制限・注意事項」を必ずご確認ください。 

 

Kiwi Syslog Server のインストーラーが表示されます。以下の例は 9.7.0 の場合。 
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ダウンロードのアイコンをクリックして、インストーラーパッケージ(.zip)を入手してください。

（例）Kiwi_Syslog_Server_9.7.0.zip 

3.4 Kiwi Syslog Server 9.7評価版インストール 

3.4.1 Kiwi Syslog Server インストール 

Kiwi Syslog Server v9.7.2 インストール手順 

1. Kiwi Syslog Server をインストールするコンピューターに管理者権限をもつアカウントでログ

インします。  

2. Kiwi Syslog Server のインストーラーパッケージ（.zip ファイル）を展開します。  

3. Kiwi Syslog Server 9.7 評価版インストーラーパッケージの exe ファイル 

（例：Kiwi_Syslog_Server_9.7.2.Eval.setup.exe）をダブルクリックして実行します。 

 

4. セキュリティの警告画面が表示された場合は、実行 をクリックします。  

5. License Agreement （ライセンス同意）画面で I Agree (同意します)をクリックします。 

 

 

6. Choose Operating Mode 画面で、Kiwi Syslog Server を 

サービスとしてインストールする場合は Install Kiwi Syslog Server as a Service、 

アプリケーションとしてインストールする場合は Install Kiwi Syslog Server as an Application 

を選択し、Next をクリックします。 
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Install Kiwi Syslog Server as a Service 

サービス版（インストール時に ”as a Service” を選択）は Windows サービスとして OS が起

動されると自動的に Kiwi Syslog Server がバックグラウンドで実行されます。 

操作のために Kiwi Syslog Server を起動してログオンする必要はありません。  

 

Install Kiwi Syslog Server as an Application 

アプリケーション版（インストール時に ”as an Application” を選択）は Kiwi Syslog Server

を起動して対話方式に実行され、ユーザーがログインしている間だけ操作できます。 

 

7. （前の手順で Install Kiwi Syslog Server as a Service を選択した場合は）サービス起動に

使用するアカウントを選択し、Next をクリックします。 

初期値は LocalSystem アカウントです。 

 

 

注意： 前の手順で Install Kiwi Syslog Server as an Application を選択した場合は、この画

面は表示されません。 
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8. Install Kiwi Syslog Web Access の画面で、Kiwi Syslog Web Access および Web Access に

記録するルールを作成するかを選択し、Next をクリックします。 

 

 

初期設定ではチェックが付いており、Kiwi Syslog Web Access をインストールし、Web Access に記

録するためのルールを作成します。  

 

注意： Kiwi Syslog Web Access をインストールしない場合は、 

□Install Kiwi Syslog Web Access（Kiwi Syslog Web Access をインストールする）のチェックをはず

してください。 

 

9. 必要に応じてインストールするコンポーネントを選択し、Next をクリックします。 
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10. 必要に応じてインストールフォルダを変更し、Install をクリックします。 

初期値は、64bit OS の場合は C:\Program Files (x86)\Syslogd です。 

 

 

11. インストールが始まり、Installing 画面にインストール処理の進捗が表示されます。 

 

 

12. Microsoft Visual C++ 2010 x86 Redistributable セットアップが開きます。  

「同意する」にチェックします。 
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13. 「インストール」を押下します。 

 

インストールが始まります。 
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14. 「完了」をクリックします。 

Kiwi Syslog Server 9.7.x のインストールが継続します。 

 

 
 

15. Microsoft Visual C++ 2013 Redistributable (x86) – 12.0.30501 が表示されます。 

「I agree to the license terms and conditions」をチェックします。 

 

 

16. 「Install」をクリックします。 
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17. 以下の画面が表示されたら「Close」をクリックします。 

 

インストールが進みます。 

 

 

18. Kiwi Syslog Web Access をインストールしない場合はインストール完了の「Completing the 

Kiwi Syslog Server 9.7.x Setup Wizard」画面が表示されます。 

Kiwi Syslog Web Access をインストールする場合は手順 20 へ進みます。 
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Finish をクリックします。 

注意： 初期設定で □Run Kiwi Syslog Server 9.x.x が選択されています。この状態で 

Finish をクリックすると、Kiwi Syslog Server のコンソール画面が起動します。 

 

 

手前のポップアップウィンドウは右上の「X」をクリックして閉じます。 

 

19. インストールされたバージョンなどの情報を確認するには、Kiwi コンソールのメニューバー

から Help> About Kiwi Syslog Server を選択すると以下のように表示されます。 

例：Kiwi_Syslog_Server_9.7.2.Eval.setup.exe をインストールした場合、 

詳細バージョンは 9.7.2.1 になります。 

 

 

注意：  

ライセンス登録は、「インストール＆ライセンス登録マニュアル」 

https://www.jtc-i.co.jp/support/documents/solarwinds_docs/KiwiSyslogServer_Install-LisenceM

anager.pdf 

 7 Kiwi Syslog Server のライセンス取得手順 

 8 Kiwi Syslog Server 9.3.3 以降のライセンス登録手順 

をご参照ください。 

https://www.jtc-i.co.jp/support/documents/solarwinds_docs/KiwiSyslogServer_Install-LisenceManager.pdf
https://www.jtc-i.co.jp/support/documents/solarwinds_docs/KiwiSyslogServer_Install-LisenceManager.pdf
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3.4.2 続けて Kiwi Web Accessをインストールする場合 

20. Kiwi Syslog Server インストールにおいて、Kiwi Syslog Web Access をインストールする場

合は、手順 17 の次に、以下の画面が表示されます。 

 

 

の画面の上に、「Welcome to the Prerequisites Setup Wizard」（前提条件セットアップウィザ

ード）画面が表示されます。Next をクリックします。 

 

 

21. Kiwi Web Access に必要な前提モジュールがシステムにインストールされていなければ、自

動でインストールされますが、.NET Framework 4.8 はインターネットに接続しているオンライ

ン環境の場合、自動でダウンロードされます。オフライン環境の場合は、Kiwi Syslog Server

インストール前にお客様において.NET Framework 4.8 をインストールしてください。 

 

Prerequisites 画面でチェックされた項目を確認し Next をクリックします。 
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以下は Kiwi Syslog Server 9.7 の画面 

Next をクリックします。 

 

22. 前提モジュールのダウンロード、インストールが始まります。 
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23. Microsoft Visual C++ 2015-2019 Redistributable (x86) のライセンス条項が表示されます。 

「ライセンス条項および使用条件に同意する」にチェックします。 

 

 

24. 「インストール」をクリックします。 

 

 

25. 「セットアップ完了」の表示で「閉じる」をクリックします。 
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26. 次の前提モジュールのインストールが始まります。 

以下の画面は SQL Server Compact 4.0 x64 をインストール中。 

 

 

注意： 既に.NET Framework 4.8 がインストールされた環境では、手順 38 へ進みます。 

 

27. .NET Framework 4.8 のインストールが始まると、 

 

28. 以下の画面「.NET Framework 4.8セットアップ」で、ライセンス条項に「同意する」をチェックし

ます。 
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29. 「インストール」をクリックします。 

 

30. .NET Framework 4.8 のインストール中 

 

31. 以下の「インストールが完了しました」画面で、「完了」をクリックします。 
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32. 再起動に関する、以下の画面が表示されます。

 

 

33. 画面上には以下のウィンドウが表示されている状況です。 

 

「今すぐ再起動」をクリックします。 

 

34. 以下の画面が表示されたら、再起動を妨げているアプリを正常に停止するために「キャン

セル」をクリックします。 

 

 

35. 以下のような「Completing the Kiwi Syslog Server 9.7.x Setup Wizard」画面が表示されます。 

□Run Kiwi Syslog Server 9.7.x のチェックを外して Finish をクリックします。 
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注意： 初期設定で □Run Kiwi Syslog Server 9.7.x が選択されています。チェックを入れた

状態で Finish をクリックすると、Kiwi Syslog Server のコンソール画面が起動します。 

もし、Kiwi コンソールを起動した場合は、コンソールを閉じるために、File>Exit または、ウィ

ンドウ右上の「X」をクリックして、コンソールを閉じます。 

 

 

36. アプリが何も起動していないことを確認したら、OS を再起動します。 

 

 

37. OS 再起動後に、管理者権限を持つアカウントでログインします。 

以下のように、Kiwi Syslog Web Access Setup 画面が自動で起動します。 
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38. Welcome to the Kiwi Syslog Web Access Setup Wizard の画面で、Next をクリックします。 

 
 

39. End-User License Agreement（エンドユーザライセンス同意）画面で、 

I accept the terms in the License Agreement 

を選択し、Next をクリックします。 

 

 

 

40. 必要に応じて作成するショートカットメニューを選択し、Next をクリックします。 

初期設定では、デスクトップ、スタートメニュー、クイック起動ツールバーにショートカットが

作成されます。 
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41. Kiwi Syslog Web Access のインストール先フォルダを指定し、Next をクリックします。 

異なるフォルダへインストールする場合はそれを入力するか”Browse”をクリックし設定しま

す。 

初期設定で、64bit OS の場合は  

C:\Program Files (x86)\SolarWinds\Kiwi Syslog Web Access\です。 

 

 

42. 必要に応じて Web サイトルートディレクトリと使用するポートを指定します。 
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注意： Website Root Folder フィールドには、前の手順の Installation Folder フィールドで

指定したパスと同じパス\html を指定してください。（下図の赤枠の部分を共通にしてくださ

い。）異なるパスを指定すると Kiwi Syslog Server のインストールに失敗します。 

 

 

Check Port （ポートチェック）をクリックして、指定したポート番号が現在使用中かどうかを

確認します。初期値は 8088 です。他のアプリケーションが既にこのポートを使用している場

合、Kiwi Syslog Web Access のインストールに失敗します。未使用のポート番号に変更して

ください。 

 

指定したポートが、「Port XXXX is free.」と表示されることを確認してください。 

 

 

（Kiwi Syslog Web Access のインストール時に Windows ファイアウォールの例外を自動定義

しない場合は）Automatically configure Web Server exception with Windows Firewall
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（Windows ファイアウォールに Web サーバーの例外を自動構成する）チェックボックスのチ

ェックを外します。Next をクリックします。 

 

43. Kiwi Web Access Website Login 画面では、Kiwi Web Access の初期ログインユーザー＝管

理者（デフォルト：Administrator）のログイン名とパスワードを設定し Next をクリックします。 

※9.6.7(KWA 1.6.1.115)以降は以下パスワードポリシーを満たす必要があります。 

 

 

パスワードポリシー要件： 

 ・パスワードをユーザー名と同じにすることは出来ません。 

 ・パスワードには、少なくとも 1 つの大文字を含めてください。 

 ・パスワードには、少なくとも 1 つの小文字を含めてください。 

 ・パスワードには、少なくとも 1 つの数字を含めてください。 

 ・パスワードには、少なくとも 1 つの特殊文字を含めてください。 

 ・Administrator（管理者）アカウントのパスワードは最低 15 文字、 

  Standard User（一般ユーザー）アカウントのパスワードは最低 8 文字です。 

※上記要件を満たさなければ、下記画面が表示されます。 

 

 

44. パスワードポリシー要件を満たしたパスワードを入力し、Next をクリックします。 
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45. Ready to Install （インストール準備）画面で Install をクリックします。 

 

 

46. Kiwi Syslog Web Access の Setup が始まります。 

 

 

47. Completing the Kiwi Syslog Web Access Setup Wizard 画面で Finish をクリックします。 
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Kiwi Syslog Web Access がインストールされました。 

 

注意：.NET Framework 4.8 が予めインストールされていた環境ではここで手順 35 の「Completing 

the Kiwi Syslog Server 9.7.x Setup Wizard」画面が表示されます。Finish をクリックすると Kiwi コン

ソールが起動しますが右上の「X」でコンソールを閉じます。 

 

48. コントロールパネル＞プログラムと機能 で、インストールされたプログラムを確認してくだ

さい。 

Kiwi Syslog Server は、v9.7.2 

Kiwi Syslog Web Access は、v1.6.2.21 となります。 

 

 

49. v9.7.でインストールされる Kiwi Web Access v1.6.2.x では、デフォルトで SSL 接続と設定され

ています。UltiDev Web Server Pro において SSL 接続設定を追加する必要があります。 

 

SSL（HTTPS）接続を利用する場合、下記 URL の記事にあるように UltiDev Web Server Pro

において SSL を有効にする必要があります。 
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Kiwi Syslog Web Access - Enabling SSL 

リンク先：https://support.solarwinds.com/SuccessCenter/s/article/Enable-SSL-support-for-Kiwi-Web-Access 

 

次の手順 50 からその方法を説明します。 

 

SSL（HTTPS）接続は必要なく、HTTP 接続を利用の場合は、手順 87 に進みます。 

 

注意： UltiDev Web Server Pro は、Kiwi Syslog Web Access の Web ページにアクセスする

ための Web サーバーアプリケーションです。 

https://support.solarwinds.com/SuccessCenter/s/article/Enable-SSL-support-for-Kiwi-Web-Access
https://support.solarwinds.com/SuccessCenter/s/article/Enable-SSL-support-for-Kiwi-Web-Access
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3.4.3 Kiwi Web Accessで SSL（HTTPS）接続を利用する場合 

50. スタート＞UltiDev Web App Explorer をクリックし、UltiDev Web App Explorer を起動します。 

 

 

51. 以下の様なスクリプトエラーが表示されたら、「いいえ」をクリックしてウィンドウを閉じます。

複数のスクリプトエラーが表示される場合があります。 
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52. 「Ecosystem to create SSL certificate」アイコンをクリックします。 

 
 

53. 「Create New Certificate」をクリックします。 

 

 

 

54. 以下のポップアップウィンドウが表示されます。 

「Create self-signed test certificate」をクリックします。 
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55. 以下の画面で SSL として機能させるホスト名または IP アドレスを選択します。 

 

 

56. この例では、localhost を選択します。 

 

 

57. 「証明書」ウィンドウに証明書の情報が表示されますので確認後、「OK」をクリックします。 
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58. 作成した証明書が表示されます。 

 

 

59. 「Click to register new site or application with UltiDev Web Server」をクリックします。 

 

 

60. 以下の画面で「ASP.NET Web Application」オプションを選択し、Next をクリックします。 
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61. Kiwi Syslog Server バージョン 9.7 以降の場合は、[ASP.NET 4.0（Full）]オプションを選択し、

Next をクリックします。 

 

 

62. 2 番目のオプション「Run as 32 bit on this 64-bit system」を選択して Next をクリックし、

「native 32-bit components」をロードします。 

 

 

63. 次の画面「Host Process」タブでは「LOCAL SYSTEM」を選択し、Next をクリックします。 
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64. 以下の画面では「Browse for default」をクリックします。 

 

 

65. イ ン ス ト ー ル デ ィ レ ク ト リ  C:\Program Files (x86)\SolarWinds\Kiwi Syslog Web 

Access\html  の Gateway.aspx ファイルを選択します。 
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66. 「Application name」を Syslogd に変更します。 

 

 

67. 「Virtual Directory」欄のデフォルト入力を削除して空白にします。 
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68. Kiwi Web Access の既存の HTTP リスンアドレスを削除します。セキュリティを高めるために、

https のみを使用することをお勧めします。それ以外の場合、ユーザーは HTTP と HTTPS

の両方でログインできます。 

 

69. HTPS/SSL Listen Addresses:で、Add をクリックします。 

 

 

70. 作成した証明書を選択し、Next をクリックします。 

 

ここを選択し 

Remove クリック 
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71. SSL のための TCP/IP ポートを Find Free Port をクリックして指定するか、入力します。 OK

をクリックします。 

 

72. HTTPS/SSL Listen Addresses 欄の入力を確認し、Next をクリックします。 

 

73. 「Anonymous」を選択し、Next をクリックします。 

 

フリーポートが表示される 
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74. Finish をクリックします。 

 

 

75. 作成されたホストは左側のパネルに表示されます。 

 

 

76. ここからブラウザーを起動し、新しい HTTPS 用ポートを試します。 

Syslogd を右クリックし、https://localhost:50203/ を選択します。 

 

 

 

https://localhost:50203/
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77. ブラウザーが開き、https を使用してホストにアクセスします。 

 

 

 

このブラウザーは、一旦閉じます。 

 

78. 次に、デスクトップ上のショートカットを利用し Kiwi Syslog Web Access にアクセスする時に、

HTTP から HTTPS へのリダイレクトを有効するために以下の手順を行います。 

参考 SolarWinds ナレッジベース：Enable HTTP to HTTPS redirection in Web Access 

https://support.solarwinds.com/SuccessCenter/s/article/Enable-HTTP-to-HTTPS-redirection-in-Web-

Access?language=en_US 

 

79. UltiDev Web Server Explorer に戻ります。（もし閉じていた場合は、スタート＞UltiDev Web 

App Explorer をクリックし起動します。） 

左側パネルには、デフォルトの html（HTTP 用 8088 ポート）と上の手順で追加した Syslogd

（HTTPS 用 例：50203 ポート）があります。 
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80. 「Click to register new site or application with UltiDev Web Server」をクリックします。 

 

 

81. 表示されたウィンドウで、Redirection to a new site location を選択して、HTTP から HTTPS

へリダイレクトのための設定を作成します。Next をクリックします。 

 
 

82. HTTP Listen Addresses:で、Add をクリックします。 

Port に 8088 を指定します。Host name or IP address では、"Specify hostname or IP 

address"を選択し、プルダウンから適切なホスト名または IP アドレスを選択します。この例

では localhost を選択しています。OK をクリックします。 
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83. Next をクリックします。 

 
 

 

84. 次にリダイレクト先の URL を指定します。HTTPS 用のホスト名とポートを指定します。(例で

は、https://localhost:50203/ ) 

Redirect all source URLs to the one above を選択し有効にします。Redirection HTTP Code

では、Permanent を選択します。Finish をクリックします。 
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リダイレクト設定が追加されました。 

 

UltiDev Web Server Explorer のウィンドウの右上「X」をクリックして、閉じます。 

 

85. デスクトップ上の Kiwi Syslog Web Access ショートカットをダブルクリックします。 

 

86. ブラウザーが開き、https を使用して Kiwi SyslogWeb Access のログイン画面が表示されれ

ばリダイレクト設定に問題はありません。 

Kiwi Syslog Server のコンソール起動確認のため手順 94 へ進みます。 
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3.4.4 Kiwi Web Accessで SSL（HTTPS）接続は必要なく、HTTP接続を利用の場合 

HTTP 接続でアクセスする場合は、以下の手順で、Kiwi Web Access での SSL（HTTPS）設定を無

効に変更してください。 

 

87. コントロールパネル＞管理ツール＞サービスまたは、「ファイル名を指定して実行」で、

services.msc を入力して、「サービス」を起動します。 

 

 

88. UltiDev Web Server Pro を右クリック＞停止で、停止します。 

 

 

89. web.config ファイルのバックアップを作成します。 

デフォルトインストールフォルダ：C:\Program Files (x86)\SolarWinds\Kiwi Syslog Web 

Access\html  

以下の例では、web.config を web.config_ORG としてコピー。 
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90. ジュピターテクノロジーのダウンロードサイトから入手した Kiwi_Syslog_Server_9.7.2.zip を解

凍後の「評価版（正規版）」フォルダ内「KWA_HTTP 対応 v972」フォルダにある web.config を

C:\Program Files (x86)\SolarWinds\Kiwi Syslog Web Access\html にある同じ名前のファイ

ルと置き換えます。 

 

※参考情報として、デフォルトのweb.configをHTTP用へ編集する箇所について後述してい

ます。 

 

91. サービス「UltiDev Web Server Pro」を開始します。 

 

 

92. デスクトップ上の「Kiwi Syslog Web Access」ショートカットをダブルクリックし、起動したブラ

ウザーに、ログイン名とパスワードを入力し「Log in」をクリックします。 

 

https://www.jtc-i.co.jp/support/download/
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93. HTTP で接続しています。 

 

 

Kiwi Syslog Server のコンソール起動確認のため次の手順へ進みます。 

 

94. Kiwi Syslog Web Accessのインストールとブラウザーでのアクセスを確認したら、Kiwi コンソ

ールを起動します。 

デスクトップ上の「Kiwi Syslog Server Console」ショートカットをダブルクリックします。 

 

 

95. Kiwi Syslog Server のコンソール画面が起動します。 



 

 

 

 

Kiwi Syslog Server 9.7.2 インストール&アップグレード 

Rev 1.3 

48 
 

 

手前のポップアップウィンドウは右上の「X」をクリックして閉じます。 

 

 

96. Kiwi Web Access をインストールしたので、Kiwi Syslog Server サービスを再起動します。 

Kiwi コンソールで、Manage >Stop the Syslogd service 

でサービスを停止し、 

Kiwi コンソールで、Manage >Start the Syslogd service 

でサービスを開始します。 

 

枠下のステータスバーに”The Syslogd service is running”と表示されればサービス実行中

です。 

 

97. インストールされたバージョンなどの情報を確認するには、Kiwi コンソールのメニューバー

から Help> About Kiwi Syslog Server を選択すると以下のように表示されます。 
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注意：  

・ライセンス登録は、「インストール＆ライセンス登録マニュアル」 

https://www.jtc-i.co.jp/support/documents/solarwinds_docs/KiwiSyslogServer_Install-LisenceM

anager.pdf 

 7 Kiwi Syslog Server のライセンス取得手順 

 8 Kiwi Syslog Server 9.3.3 以降のライセンス登録手順 

をご参照ください。 

 

 

以上で ｖ9.7.2 インストールは完了です。 

 

 

https://www.jtc-i.co.jp/support/documents/solarwinds_docs/KiwiSyslogServer_Install-LisenceManager.pdf
https://www.jtc-i.co.jp/support/documents/solarwinds_docs/KiwiSyslogServer_Install-LisenceManager.pdf
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参考情報： 

「KWA_HTTP 対応 v972」フォルダの web.config は、デフォルトの web.config ファイル内の SSL 設

定記述の 2 か所を変更し、SSL 設定要求を無効としています。 

 

① 

変更前：<authentication mode="Forms" 

    <forms name="Kiwi" loginUrl="~/Gateway.aspx" requireSSL="true">  

変更後：<authentication mode="Forms" 

    <forms name="Kiwi" loginUrl="~/Gateway.aspx" requireSSL="false"> 

② 

変更前：<httpCookies requireSSL="true" /> 

変更後：<httpCookies requireSSL="false" /> 

 

 

①の部分の編集後 

 

②の部分の編集後 
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4 9.7.0/9.7.1から 9.7.2へアップグレード 

本章では、Kiwi Syslog Server 9.7.0/9.7.1 を 9.7.2 にアップグレードする手順を紹介します。 

「コードサイニング証明書更新に伴うアップデート」のために、v9.7.0/9.7.1 から v9.7.2 へアップグレ

ードされる場合にご参照ください。 

 

Kiwi Syslog Server(KSS) のインストールが既に完了していることを前提としています。 

KSS をインストールしていない場合は、「Kiwi Syslog Server インストール手順」に記載の手順でイ

ンストールを行ってください。 

 

Kiwi Syslog Server をアップグレードするには、以前のバージョンをアンインストールし、新しいバー

ジョンをインストールします。KSS をアンインストールしても、ファイルに記録されたログメッセージ、

KSS のルールや設定は保持されます。登録済みのライセンスは、新しいバージョンに自動的に適

用されます。 

 

4.1 アップグレードの準備 

□ 

 

リリースノートの確認 Kiwi Syslog Server バージョンヒストリーでリリース情報を確認します。 

□ 

 

システム要件を確認 インストールするコンピューターがハードウェアとソフトウェアの最小

要件を満たしているか等、システム要件を確認します。 

前提モジュールについてはインストールするプログラムや環境に応じ

た必要な対応をしてください。 

□ 

 

Windows Update Windows Update を最新の状態にしてください。Windows Update が実

行されると、システム再起動が必要となる場合があります。 

□ 

 

バックアップ 「 4.2 バ ッ ク ア ッ プ の 取 得 」 に 記 載 の 設 定 フ ァ イ ル （ ini) 、

StaticHosts.txt、Kiwi Web Access のデータベースを取得します。 

□ ウイルス対策ソフトウ

ェア（アンチウイルス

ソフト）を確認 

Kiwi Syslog Server をインストールするコンピューターにアンチウイル

スソフトがインストールされてあれば、製品に関連するディレクトリを

除外します。 

例：Windows Server 2016 では、次のディレクトリを除外します。 

 C:\Program Files (x86)\Syslogd 

 C:\Program Files (x86)\UltiDev 

 C:\ProgramData\SolarWinds\ 

https://www.jtc-i.co.jp/support/releasenote/releasenote_kiwisyslog.html
https://www.jtc-i.co.jp/product/kiwisyslogserver/kiwisyslogserver_system.html
https://www.jtc-i.co.jp/product/kiwisyslogserver/kiwisyslogserver_system.html
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 C:\ProgramData\UltiDev 

関連情報が Kiwi FAQ Q4-5: アンチウイルスソフトのスキャン対象外

にする必要がありますか？にありますのでご参照ください。 

※Kiwi Syslog Server インストール前に除外設定が出来ない場合は

インストール後に設定を行ってください。 

 

4.2 バックアップの取得 

以下のバックアップを取得します。なお、これらの取得時に Kiwi Syslog Server や Web Access 関

係のサービスを停止する必要はありません。 

 設定ファイル（.ini）手順： 

Kiwi Syslog Server の Console を起動し、 

File>Export settings to INI file  

で設定ファイル（Syslog_Server_Settings.ini）を任意の場所に保存します。 

Kiwi Syslog Server の設定内容は、レジストリに登録されており、Kiwi Syslog Server のア

ンインストールでは、このレジストリ情報を削除しません。このため、Kiwi Syslog Server

の再インストールやバージョンアップ時には以前の設定がそのまま引き継がれますが、

念のために、設定ファイルをエクスポートしておくことをお勧めします。 

※ライセンス登録情報もマシン上に残っています。（アンインストールしてもライセンス情

報は残っています。） 

 StaticHosts.txt （DNS 名前解決固定 hosts ファイル） 

もし、名前解決設定で、StaticHosts.txt を指定されている場合は、このファイルもバックア

ップしてください。 

 Kiwi Web Access をご利用の場合は、 

C:¥Program Files (x86)¥SolarWinds¥Kiwi Syslog Web Access¥html¥App_Data フォルダ

（デフォルト）のバックアップにより、Web Access のデータベースや設定のバックアップと

なります。 

参考までに、Web Access 用にログが保存されるデータベースは、 

C:¥Program Files (x86)¥SolarWinds¥Kiwi Syslog Web Access¥html¥App_Data 下の 

Event.sdf, Event#.sdf （#は数字）です。 

Web Access におけるアカウント設定、Filter 設定、Highlighting 設定は、System.sdf に保

存されています。 

 

 

https://www.jtc-i.co.jp/faq/faq_kiwisyslog.html
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4.3 サービスの停止 

98. コンソール画面より、Manage＞Stop the Syslogd service で Kiwi Syslog Server のサービス

を停止します。 

99. コンソール画面を閉じます。 

100. Kiwi Web Access 使用時は UltiDev Web Server Pro サービスも停止します。ファイル名を指

定して実行＞service.msc を実行し、サービス一覧より、 

サービス名：UltiDev Web Server Pro 

を停止してください。 

 

 

4.4 Kiwi Syslog Serverをアンインストール 

101. コントロールパネル＞プログラムと機能 を開き、Kiwi Syslog Server 9.x.x 上で右クリック＞

アンインストールを選択します。 

 

 

102. Uninstall Kiwi Syslog Server 9.x.x 画面で、Uninstall をクリックします。 



 

 

 

 

Kiwi Syslog Server 9.7.2 インストール&アップグレード 

Rev 1.3 

54 
 

 

 

アンインストールが開始します。 

 

103. Kiwi Syslog Web Access をインストールしている場合に、Kiwi Syslog Server のアンインスト

ール時に「Uninstall Kiwi Syslog Web Access as well?」メッセージが出た際には「はい」をク

リックします。  

 

 

104. Uninstallation Complete（アンインストール完了）画面で Close をクリックします。 

 

 

 



 

 

 

 

Kiwi Syslog Server 9.7.2 インストール&アップグレード 

Rev 1.3 

55 
 

注意：  

・Kiwi Syslog Server の設定内容はレジストリに登録されています。Kiwi Syslog Server のアンイ

ンストールでは、このレジストリ情報を削除しません。 このため、Kiwi Syslog Server の再インス

トールやバージョンアップ時には以前の設定がそのまま引き継がれます。  

なお、バージョンアップの場合は、ルールフィルタやアクションが一部更新されていますので、バ

ージョンアップ後に正しく設定が引き継がれているか（実際の Action の項目がずれていないか

等）のご確認をお願いいたします。 

・Kiwi Syslog Server(9.3.3 以降)のアンインストールで、ライセンス登録情報も削除されません。

バージョンアップ時にはライセンス登録情報が引き継がれます。 

 

4.5 アップグレードのインストール 

4.5.1 前提モジュールについて 

9.7.0/9.7.1 から 9.7.2 へアップグレードする場合は、既に前提モジュールがインストールされていま

す。 

 

4.5.2 KSSのインストーラーパッケージ（.zipファイル）について 

最新バージョンのインストーラーを弊社のダウンロードサイトから入手してください。 

 

詳しくは、「3.3 Kiwi Syslog Server 9.7.x 評価版インストーラーパッケージ(.zip)の入手」を参照してく

ださい。 

4.5.3 v9.7.0/9.7.1から 9.7.2へアップグレード手順 

v9.7.0/9.7.1 から 9.7.2 へアップグレードする場合の操作を説明します。 

105. Kiwi Syslog Server をインストールするコンピューターに管理者権限をもつアカウントでログ

インします。  

106. Kiwi Syslog Server のインストーラーパッケージ（.zip ファイル）を展開します。  

 

107. Kiwi Syslog Server 9.7 評価版インストーラーパッケージの exe ファイル 

（例：Kiwi_Syslog_Server_9.7.2.Eval.setup.exe）をダブルクリックして実行します。 

 

108. インストーラーが起動します。 

I agree を選択します。 
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109. サービスとしてインストールする場合、Install Kiwi Syslog Server as a Service を選択します。 

 

 

110. サービス起動のアカウントを選択します。以下の画面は LocalSystem を選択。 
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111. Kiwi Web Access をインストールしない場合は、 

□Install Kiwi Syslog Web Access のチェックを外します。 

 

Kiwi Web Access をインストールする場合は、 

☑Install Kiwi Syslog Web Access にチェックを残し、 

□Create a new Web Access logging rule in Kiwi Syslog Server  

のチェックは外し、新しくルールを追加しないようにします。 

 

 

 

112. デフォルトのままで Next をクリックします。 

 

 

113. 旧バージョンと同じフォルダにインストールします。画面はデフォルト設定です。 

Install をクリックします。 
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インストールが始まります。 

 

Kiwi Web Access をインストールしない場合は、以下のような「Completing the Kiwi Syslog 

Server 9.7.x Setup Wizard」画面が表示されます。 

Kiwi Web Access をインストールする場合は、手順 115 へ進みます。 

 

 

 

114. Finish をクリックします。 

注意： 初期設定で □Run Kiwi Syslog Server 9.x.x が選択されています。この状態で 

Finish をクリックすると、Kiwi Syslog Server のコンソール画面が起動します。 
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手前のポップアップウィンドウは右上の「X」をクリックして閉じます。 

設定やライセンス情報が引き継がれているかを確認するため、手順 125 へ進みます。、 

 

115. Kiwi Web Access をインストールする場合、以下の画面が表示されます。Next をクリックし

ます。 

 
 

 

116. End-User License Agreement（エンドユーザライセンス同意）画面で、 

I accept the terms in the License Agreement 

を選択し、Next をクリックします。 
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117. 初期設定では、デスクトップ、スタートメニュー、クイック起動ツールバーにショートカットが

作成されます。Next をクリックします。 

 

 

118. Kiwi Syslog Web Access のインストール先フォルダを指定し、Next をクリックします。初期設

定で、64bit OS の場合は  

C:\Program Files (x86)\SolarWinds\Kiwi Syslog Web Access\です。 

 

 

119. 必要に応じて Web サイトルートディレクトリと使用するポートを指定します。 
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注意： Website Root Folder フィールドには、前の手順の Installation Folder フィールドで

指定したパスと同じパス\html を指定してください。（下図の赤枠の部分を共通にしてくださ

い。）異なるパスを指定すると Kiwi Syslog Server のインストールに失敗します。 

 

 

Check Port （ポートチェック）をクリックして、指定したポート番号が現在使用中かどうかを

確認します。初期値は 8088 です。他のアプリケーションが既にこのポートを使用している場

合、Kiwi Syslog Web Access のインストールに失敗します。未使用のポート番号に変更して

ください。 

 

指定したポートが、「Port XXXX is free.」と表示されることを確認してください。 

 

 

Automatically configure Web Server exception with Windows Firewall（Windows ファイアウ

ォールに Web サーバーの例外を自動構成する）をチェックしたままで Next をクリックします。 
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120. Kiwi Web Access Website Login 画面では、Kiwi Web Access の初期ログインユーザー＝管

理者（デフォルト：Administrator）のログイン名とパスワードを設定し Next をクリックします。 

※9.6.7(KWA 1.6.1.115)以降は以下パスワードポリシーを満たす必要があります。 

 

パスワードポリシー要件： 

 ・パスワードをユーザー名と同じにすることは出来ません。 

 ・パスワードには、少なくとも 1 つの大文字を含めてください。 

 ・パスワードには、少なくとも 1 つの小文字を含めてください。 

 ・パスワードには、少なくとも 1 つの数字を含めてください。 

 ・パスワードには、少なくとも 1 つの特殊文字を含めてください。 

 ・Administrator（管理者）アカウントのパスワードは最低 15 文字、 

  Standard User（一般ユーザー）アカウントのパスワードは最低 8 文字です。 

※上記要件を満たさなければ、下記画面が表示されます。 

 

 

121. パスワードポリシー要件を満たしたパスワードを入力し、Next をクリックします。 
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122. Ready to Install （インストール準備）画面で Install をクリックします。 

 

 

123. Kiwi Syslog Web Access の Setup が始まります。 

 

 

124. Kiwi Syslog Web Access がインストールされました。 

Completing the Kiwi Syslog Web Access Setup Wizard 画面で Finish をクリックします。 
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。 

以下の画面が表示されます。 

 

Finish をクリックします。 

注意： 初期設定で □Run Kiwi Syslog Server 9.x.x が選択されています。この状態で 

Finish をクリックすると、Kiwi Syslog Server のコンソール画面が起動します。 

 

手前のポップアップウィンドウは右上の「X」をクリックして閉じます。 

 

125. Kiwi コンソールの File>Setup で、バージョンアップにより設定がずれたりしていないかを確

認してください。 
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旧バージョンで Action: Log to Kiwi Syslog Web Access を指定している場合に、バージョン

アップにより、そのアクションが、その下側の Action: Reset Flags/Counters になった事例が

あります。 

 

126. インストールされたバージョンなどの情報を確認するには、Kiwi コンソールのメニューバー

から Help> About Kiwi Syslog Server を選択すると以下のように表示されます。 

例：Kiwi_Syslog_Server_9.7.2.Eval.setup.exe をインストールした場合、 

詳細バージョンは 9.7.2.1 になります。 

 

※アップグレードの場合、ライセンスが適用済みであることを確認します。 

Activation Key: 

Software Maintenance Expiry Date: 

を確認してください。 

 

 

127. コントロールパネル＞プログラムと機能 で、インストールされたプログラムを確認してくだ

さい。 

Kiwi Syslog Server は、v9.7.2 

Kiwi Syslog Web Access は、v1.6.2.21 となります。 
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4.6 アップグレード時の Kiwi Web Accessの SSL設定と HTTP設定について 

SSL 設定の場合 

9.7.0/9.7.1 インストール時に、SSL 設定を行った場合、UltiDev に設定が残っていますので、再度

設定する必要はありません。 

 

HTTP 設定の場合 

9.7.0/9.7.1 インストール時に、HTTP 設定にした場合でも、 

「3.4.4 Kiwi Web Access で SSL（HTTPS）接続は必要なく、HTTP 接続を利用の場合」で、再度

HTTP 用の web.config へ置換を行ってください。 

 

4.7 Kiwi Web Accessのバックアップデータを戻す 

Kiwi Web Access のデータベースをバックアップから戻します。 

 

128. Windows のスタートメニューから、ファイル名を指定して実行＞service.msc を実行し、サー

ビス一覧より、 

Kiwi Syslog Server 

UltiDev Web Server Pro 

を停止してください。 

 

129. データベースが格納されている 

C:¥Program Files (x86)¥SolarWinds¥Kiwi Syslog Web Access¥html¥App_Data フォルダをリネームし、

「4.2 バックアップの取得」で取得した App_Data フォルダを同フォルダにコピーします。 
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130. 以下のサービスを開始します。 

Kiwi Syslog Server 

UltiDev Web Server Pro 

 

131. デスクトップ上の「Kiwi Syslog Server Console」ショートカットをダブルクリックして Kiwi Web 

Access を起動し、ログインします。 

 

 

バックアップから戻したログデータや設定(Filter 設定、ハイライト設定、Setting 等)を確認し

てください。 

 

以上でアップグレード作業は終わりです。 

 

 

 

 

 

 

 

 

本文書に関する諸権利は、特に記載されているもの以外は、すべてジュピターテクノロジー株式 

会社に帰属しており、著作権法上認められた場合を除き、無断使用・無断転載を禁止します。 
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